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User Manual of Safire Control Center

Thank you for purchasing our product. If there is any question or request, please do not hesitate to
contact the dealer.

This manual applies to Safire Control Center.

This manual may contain several technically inaccurate points or printing errors, and the content is
subject to change without notice. The updates will be added into the new version of this manual. We
will readily improve or update the products or procedures described in the manual.
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Chapter 1 Overview

1.1 Description

Safire Control Center is a versatile video management software for the DVRs, NVRs, IP cameras,
encoders, decoders, etc. It provides multiple functionalities, including real-time live view, video
recording, remote search and playback, file backup, etc., for the connected devices to meet the needs
of monitoring task. With the flexible distributed structure and easy-to-use operations, the client
software is widely applied to the surveillance projects of medium or small scale.

This user manual describes the function, configuration and operation steps of Safire Control Center
software. To ensure the properness of usage and stability of the software, please refer to the contents
below and read the manual carefully before installation and operation.

1.2 Running Environment

Operating System: Microsoft Windows 7/Windows 2008(32/64-bit operating system), Windows
2003/Windows XP(32-bit operating system)

CPU: Intel Pentium IV 3.0 GHz or above

Memory: 1G or above

Display: 1024*768 or above
s

2

[nore]

® For high stability and good performance, these above system requirements must be met.

® The software does not support 64-bit operating system; the above mentioned 64-bit operating
system refers to the system which supports 32-bit applications as well.

1.3 Function Modules

Control Panel of Safire Control Center:
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193513 @ - O %

Network 0% CPU.0% Memory.6%

oot
IEI'
Operation and Control
e B 5
WMain Viow Remota Playb., £ map
Maintenance and Management
2 & = 4 a L
Device Manaq... Event Manage... Record Sched... Account Mana.. Log Search System Config...
S PRI
Menu Bar:
Open Captured picture Search and view the captured pictures stored on local PC.
- Open Video File Search and view the video files recorded on local PC.
Open Log File View the backup log files.
Exit Exit the Safire Control Center client software.
Lock Lock screen operations. Log in the client again to unlock.
Switch User Switch the login user.
System - - ) -
Import System Config File Import client configuration file from your computer.
Export System Config File Export client configuration file to your computer.
1024*768 Display the window at size of 1024*768 pixels.
1280*1024 Display the window at size of 1280*1024 pixels.
1440*900 Display the window at size of 1440*900 pixels.
1680*1050 Display the window at size of 1680*1050 pixels.
_— Full Screen Display the window in full screen.
Control Panel Enter Control Panel interface.
Main View Open Main View page.
Remote Playback Open Remote Playback page.
E-map Open E-map page.
Auxiliary Screen Preview Open Auxiliary Screen Preview window.
Device Management Open the Device Management page.
Tool Event Management Open the Event Management page.
Record Schedule Open the Record Schedule page.
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Account Management Open the Account Management page.
Log Search Open the Log Search page.
System Configuration Open the System Configuration page.
Broadcast Select device to start broadcasting.
Device Arming Control Set the arming status of devices.
1/0 Control Turn on/off the alarm output.
Player Open the player to play the video files.
Message Queue Display the information of Email message to be sent.
Open Wizard Open the guide for the client configuration.
Click to open the User Manual; you can also open the User
User Manual (F1) .
Hel Manual by pressing F1 on your keyboard.
elp , — , ,
About View the basic information of the client software.
Select the language for the client software and reboot the
Language . .
software to activate the settings.

The Safire Control Center client software is composed of the following function modules:
The Main View module provides live view of network cameras and video encoders, and
supports some basic operations, such as picture capturing, recording, PTZ control, etc.

The Remote Playback module provides the search, playback, export of record files.

The E-map module provides the displaying and management of E-maps, alarm inputs, hot
regions and hot spots.
@ The Device Management module provides the adding, modifying and deleting of different
s | devices and the devices can be imported into groups for management.
: The Event Management module provides the settings of arming schedule, alarm linkage
é actions and other parameters for different events.

o The Record Schedule module provides the schedule settings for recording.

LN
= The Account Management module provides the adding, modifying and deleting of user
i accounts and different permissions can be assigned for different users.
The Log Search module provides the query of system log files and the log files can be
A filtered by different types.
.'_ The System Configuration module provides the configuration of general parameters, file
b saving paths, alarm sounds and other system settings.

—
Click the icon L] in the upper-left corner of the interface to show the Menu List.
The function modules can be easily accessed by clicking the navigation buttons on the control panel or

by selecting the function module name from the View or Tool menu.

You can check the information, including current user, network usage, CPU usage, memory usage and
time, at the top of the main page.
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Chapter 2 Live View

2.1 User Registration and Login

For the first time to use Safire Control Center client software, you need to register a super user for
login.

Steps:

1. Input the super user name and password.

2. Confirm the password.

3. Optionally, check the checkbox Enable Auto-login to log in the software automatically.

4. Click Register. Then, you can log in the software as the super user.

| Register Administrator x

Please create a super user before proceeding

Super User: Il
Password:
Confirm Password:

Enable Auto-login

Register | Cancel

L.
[Nore]
®  Auser name cannot contain any of the following characters: /\:*?“<> |
® The password cannot be empty and the length of the password should be no less than six
characters.

When opening Safire Control Center after registration, you can log in the client software with the
registered user name and password.

Steps:

1. Input the user name and password you registered.

2. Optionally, check the checkbox Enable Auto-login to log in the software automatically.

3. Click Login.

User Mame: root e

Password:

Enable Auto-login

Login Cancel

After running the client software, a wizard will pop up to guide you to add the device and do some
7
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basic settings.

2.2 Adding the Encoding Device

Purpose:

After running the Safire Control Center, devices including network cameras, video encoders, DVRs,

NVRs, should be added to the client for the remote configuration and management, such as live view,

playback, alarm settings, etc.

Perform the following steps to enter the Encoding Device Adding interface:

Click the & icon on the control panel,

or click Tools->Device Management to open the Device Management page.
Click the Server tab.

Click Encoding Device to enter Encoding Device Adding interface.

= S &  Group
Cuganizaton Do tar Managamant (0]
| Enedngtees | A Deice o Dislets upgts Comng Refteshi Al
A Hew Deice Tros Nickname  « (P Daacs Sanal hin. Mt Stz HODSaus e

Online Device {2} Retesh Every 153

Aad to Client Add Al Modry Mabinfy Rastore Detault Fasswerd Filte
L =  Deuce Type Fait Device Serial No Added

17262364 CE-301BHFI-ET 000 DE-9018HF-ET1E20 11 HEVU Mo

WZea3am E5-2CDE4045-0V1 000 DE-ZCOB404C-OYIDIZIENZICORRAIDIBNEIT Mo

You can add the device in the following ways:

By detecting the online devices, see Section 2.2.1 Adding Online Devices.

By specifying the device IP address, see Section 2.2.2 Adding Devices Manually.
By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment.
By IP Server, see Section 2.2.4 Adding Devices by IP Server.

By HIDDNS, see Section 2.2.5 Adding Devices by HiDDNS.

2.2.1 Adding Online Devices

Purpose:

The active online devices in the same local subnet with the client software will be displayed on a list.
You can click the Refresh Every 15s button to refresh the information of the online devices.

Steps:

1.

Select the devices to be added from the list.
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Click Add to Client to open the device adding dialog box.

Input the required information.

Nickname: Edit a name for the device as you want.

Address: Input the device’s IP address. The IP address of the device is obtained automatically in
this adding mode.

Port: Input the device port number. The default value is 8000.

User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password. By default, the password is 12345.

Optionally, you can check the checkbox Export to Group to create a group by the device name. All
channels and alarm inputs of the device will be imported to the corresponding group by default.
Click Add to add the device.

You can also click-and-drag the online device to Device for Management area to add the device.

Adding Mode:
= IF/Demain IP Seqment P Server HIDDNES
Add Offline Davice
Mickname:
AdOress: 172623177
Port: 8000
UzerName:
Password:
-/ Expon to Group
Setthe device name as the group name and add all the channels
connected to the device to the group.

Click Add All, input the user name and password, and you can add all the online devices to the client
software.

Select the device from the list, click Modify Netinfo, and then you can modify the network
information of the selected device.

Select the device from the list, click Restore Default Password, and input the security code. Then you
can restore the default password of the selected device.

2.2.2 Adding Devices Manually

Steps:

1. Click Add Device to open the device adding dialog box.
2. Select IP/Domain as the adding mode.

3. Input the required information.

Nickname: Edit a name for the device as you want.

Address: Input the device’s IP address or domain name.

Port: Input the device port number. The default value is 8000.

User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
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4,

5.

Optionally, you can check the checkbox Export to Group to create a group by the device name. All
channels and alarm inputs of the device will be imported to the corresponding group by default.
Click Add to add the device.

Add »*

Adding Mode:
= IF/Demain IP Seqment IP Server HIDDNS
Add Offline Davice
Mickname:
Address:
Port: 8000
UzerName:
Password:
-/ Expon to Group
Setthe device name as the group name and add all the channels
connected to the device to the group.

2.2.3 Adding Devices by IP Segment

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select IP Segment as the adding mode.
3. Input the required information.
Start IP: Input a start IP address.
End IP: Input an end IP address in the same network segment with the start IP.
Port: Input the device port number. The default value is 8000.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
channels and alarm inputs of the device will be imported to the corresponding group by default.
5. Click Add, and the device of which the IP address is between the start IP and end IP will be added

to the device list.

10
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Adding Mode:

IF/Diemain = IP Segmerit 1P Server HIDDHS

Add Offline Davice

StartIP:

Eng 1P
Port: 8000

UzerName:

Password:

-~/ Expon to Group
Create group with davice IP.

2.2.4 Adding Devices by IP Server

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select IP Server as the adding mode.
3. Input the required information.
Nickname: Edit a name for the device as you want.
Server Address: Input the IP Server address.
Device ID: Input the device ID registered on the IP server.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
channels and alarm inputs of the device will be imported to the corresponding group by default.
5. Click Add to add the device.

Adding Mode:

IF/Diemain IP S2gmernt = 1P Sever HIDDHS

Add Offline Davice

Mickname:

SenerAddress:
Device ID:

UzerName:

Password:

-/ Expon to Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

11
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2.2.5 Adding Devices by HiDDNS

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select HIDDNS as the adding mode.
3. Input the required information.
Nickname: Edit a name for the device as you want.
Server Address: www.hiddns.com.
Device Domain Name: Input the device domain name registered on HiDDNS server.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
channels and alarm inputs of the device will be imported to the corresponding group by default.
5. Click Add to add the device.

Adding Mode:

IPIDomain IP Segment IP Server @ HIDDNS

Add Offline Device

Mickname:

ServerAddress: www.hiddns.com
Device Domain Name:

User Name:

Password:
-/ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

L.
[norel
Safire Control Center also provides a method to add the offline devices. Check the checkbox Add
Offline Device, input the required information and the device channel count, and then click Add.
When the offline device comes online, the software will connect it automatically.

The devices will be displayed on the device list for management after added successfully. You can
check the resource usage, HDD status, recording status, and other information of the added devices
on the list.

Click Refresh All to refresh the information of all added devices. You can also input the device name in
the filter field for search.

Select device from the list, click Modify/Delete, and then you can modify/delete the information of
the selected device.

Select device from the list, click Remote Config, and then you can do some remote configurations of
the selected device if needed.

12
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2.3 Group Management

Purpose:

The devices added can be organized into groups for a convenient management. You can get the live
video, play back the record files, and do other operations of the device through the group.

Before you start:

Devices need to be added to the client software for group management.

Perform the following steps to enter the Group Management interface:
1. Open the Device Management page.
2. Click the Group tab to enter the Group Management interface.

B Bear & G
o AIDGOUR. g Delste Group
impio: My sty e Com liee

Hicmams - P DiEnce Seral N

Adding the Group

Steps:

1. Click Add Group to open the Add Group dialog box.

2. Inputa group name as you want.

3. Click OK to add the new group to the group list.
You can also check the checkbox Create Group by Device Name to create the new group by the
name of the selected device.

Add Group

Group Name:

Create Group by Device Mame

Importing Encoding Device to Group
13
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Steps:
1. Click Import on Group Management interface, and then click the Encoding Channel tab to open
the Import Encoding Channel page.
Select the thumbnails/names of the encoding channels in the thumbnail/list view.
Select a group from the group list.
Click Import to import the selected encoding channels to the group.
You can also click Import All to import all the encoding channels to a selected group.
LIS
vore]
® You can also click the icon "2 on the Import Encoding Channel page to add a new group.
® Up to 64 cameras can be added to one group.

- EronangThene e Alwmonput

The following buttons are available on the Import Encoding Channel page:

==
ﬂﬁ
@

A
s

List View View the encoding channel in list view.

Thumbnail View View the encoding channel in thumbnail view.

Refresh Refresh the latest information of added encoding channels.
Import Create a group by device name and import the device to group.

«

Collapse/Expand Collapse/Expand the thumbnails of encoding channels.

Modifying the Group/Channel

Steps:

1.

2.
3.
4

Select the group/channel from the group list on the Import Encoding Channel page.

Click &, or double-click the group/channel name to open Modify Group/Camera dialog box.
Edit the group/channel information, including the group/camera name, the camera type, etc.

Click OK to save the new settings.
You can also double-click the group/channel name on the Group Management interface to open
the Modify Group/Camera dialog box.

14
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Mame: [IPC1_Camera1| ]
Camera Type: Main Stream ~
Protocol Type: TCP ~
Modify Group
[iPc Copy to...

Removing Channels from the Group

Steps:
1. Select the channel from the group list on the Import Encoding Channel page.

2. Click “ to remove the channel from the group.
You can also select the channel on the Group Management interface, and then click Delete to

remove the channel from the group.

Select the group from the group list on the Import Encoding Channel page, and Click . You can
remove all the channels from the group.

Deleting the Group

Steps:
1. Select the group on the Group Management interface
2. Click Delete Group or click the icon ~* and the selected group will be deleted.

2.4 Basic Operations in Live View

Purpose:

For the surveillance task, you can view the live video of the added network cameras and video
encoders on the Main View page. And some basic operations are supported, including picture
capturing, manual recording, PTZ control, etc.

Before you start:

A camera group is required to be defined for live view.

Click the @ icon on the control panel,

or click View->Main View to open the Main View page.

15
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1

o 1-8creen |
o 4-Ecreen

Cameia

:
2— T ]
IFCa

PTZ Cortral

01 Presett

5

Main View Page
1 View List
2 Camera List
3 PTZ Control Panel
4 Display Window of Live View

5 Live View Toolbar

Camera Status:

The camera is online and works properly.
The camera is in live view.

The camera is in recording status.

The camera is offline.

L5 S

Live View Toolbar:

CIRNRIEYE:SS i

On the Main View page, the following toolbar buttons are available:
Set the screen layout mode and save the new settings for the

E Set View ) ) .
current view; save the current view as another new view.

] Stop Live View Stop the live view of all cameras.
- Previous Go for live view of the previous page.
= Next Go for live view of the next page.

Resume/Pause . o .
G . Click to resume/pause the auto-switch in live view.
7 Auto-switch
[} Show /Hide the Menu  Show/Hide the config menu of auto-switch. Click again to hide.
4 &% Mute/Audio On Turn off/on the audio in live view
(L Full Screen Display the live view in full screen mode. Press ESC to exit.

16



User Manual of Safire Control Center

Right-click on the display window in live view to open the Live View Management Menu:

B Stop Live View

I Capture

= Print Captured Picture

&= Send Email

BS startRecording

<> Open Window PTZ Control

@, Open Digital Zoom

% Switch to Instant Playback #

Start Two-way Audio
Enable Audio

£ [

Camera Status

§a L.

Remote Configuration
=/ Synchronization

Full Screen

88

The following buttons are available on the right-click Live View Management Menu:

u Stop Live View Stop the live view in the display window.
= Capture Capture the picture in the live view process.
= Print Captured Picture  Capture the current picture and then print the picture.
Capture the current picture and then send an Email notification to
= Send Email . .
one or more receivers. The captured picture can be attached.
Bf @ start/Stop Recording Start/Stop the manual recording. The record file is stored in the PC.
& Open Window PTZ Enable PTZ control function on the display window. Click again to
Control disable the function.
Q Open Digital Zoom Enable the digital zoom function. Click again to disable the function.
Switch to Instant . .
= Switch to instant playback mode.
Playback
Start/Stop Two-way . . - .
[ Audi Click to start/stop the two-way audio of the camera in live view.
uaio
g2 )  Enable/Disable Audio Click to enable/disable the audio in live view.
Display the status of the camera in live view, including the recording
€ Camera Status . .
status, signal status, connection number, etc.
b Remote Configuration  Open the remote configuration page of the camera in live view.
Synchronization Sync the camera in live view with the PC running the client software.
22 Full Screen Display the live view in full screen mode. Click the icon again to exit.

2.4.1 Starting and Stopping the Live View

Starting Live View for One Camera

Steps:
1. Open the Main View page.

2. Optionally, click the Ed icon in live view toolbar, then click the screen layout buttonE&l and
17
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select the screen layout mode for live view.
3. Click-and-drag the camera to the display window,

or double-click the camera name after selecting the display window to start the live view.
s

2

NoTE

You can click-and-drag the video of the camera in live view to another display window if needed.

Starting Live View for Camera Group

Steps:
1. Open the Main View page.
2. Click-and-drag the group to the display window,

or double-click the group name to start the live view.
s

2

NoTE

The display window number is self-adaptive to the camera number of the group.

Starting Live View in Default View Mode

Purpose:
The video of the added cameras can be displayed in different view modes. 4 frequently-used default
view modes are selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen.
Steps:
1. Open the Main View page.
2. Clicktheicon *  to expand the default view list.
3. Click to select the default view mode, and the video of the added cameras will be displayed in a

sequence in the selected view.

o
[Nore|
Right-click the current default view name on the list and click Save View As., and you can save
the default view as a custom view.

Starting Live View in Custom View Mode

Purpose:

The view mode can also be customized for the video live view.

Steps:

1. Open the Main View page.

Click the icon '*. to expand the custom view list.

Click New View in the custom view list to create a new view.

Input the view name and click Add. The new view is of 4-Screen mode by default.

a > wD

Optionally, Click the B icon in live view toolbar, then click the screen layout button Bk and
select the screen layout mode for the new view.

6. Click-and-drag the camera/group to the display window,

or double-click the camera/group name in custom view mode to start the live view.

7. Click the icon Eﬁ‘ to save the new view.

18
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Right-click the custom view name on the list, and a menu pops up as follows:

= EditView Name
Iii Delete View
e Save View

&6 Save ViewAs.

The following buttons are available on the right-click menu:

Edit View Name Edit the name of the custom view.

I Delete View Delete the custom view.

EH  Save View Save the new settings of the custom view.

=, Save View As. Save the current view as another custom view.

Stopping the Live View

Steps:

1. Select the display window.

2. Click the icon . that appears in the upper-right corner when the mouse pointer is over the
display window,
or click Stop Live View on the right-click menu to stop the live view of the display window.
You can also click the button ™ in live view toolbar to stop all the live view.

2.4.2 Auto-switch in Live View

Camera Auto-switch

Purpose:

The video stream of the cameras from the same group will switch automatically in a selected display
window in camera auto-switch.

Steps:

1. Open the Main View page.

Select a display window for camera auto-switch.

-

Click the icon in the toolbar and select the switching interval.

Select a group and click the icon 2 onthe group node.

a b~ DN

You can click the icon Gi/# in the live view toolbar to pause/resume the camera auto-switch.

Single View Auto-switch

Purpose:

The video of all the cameras on the camera list will switch automatically in a selected default view in
single view auto-switch.

Steps:

1. Open the Main View page.

-

2. Click the icon in the toolbar and select the switching interval.
3. Select a default view and click the icon *2 on the selected view node.
4

You can click the icon &/ to pause/resume the single view auto-switch.
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Multi-view Auto-switch

Purpose:

The custom views will switch automatically in multi-view auto-switch. The custom views need to be
added before proceeding.

Steps:

1. Open the Main View page.

-

2. Click the icon in the toolbar and select the switching interval.
3. Clicktheicon " on the custom view node.
4

You can click the icon &e/#\ to pause/resume the multi-view auto-switch.

2.4.3 PTZ Control in Live View

The software provides PTZ control for cameras with pan/tilt/zoom functionality. You can set the preset,
patrol and pattern for the cameras on the PTZ Control panel. And you can also open window PTZ
control for the operations of PTZ cameras.

M

Click the icon to expand the PTZ Control panel.

PTZ Control v

mE e @ I
Preset Pattern Patrol

[ Rl

01 Preset1
02 Preset2 | ‘
03 Preset3 1
04 Presetd

05 Presets

The following buttons are available on the PTZ Control panel:
Zoom

Focus

Iris

Ok P

Auxiliary Focus
3D Positioning
Light

Wiper

§+B

Lens Initialization

Configuring the Preset
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A preset is a predefined image position which contains information of pan, tilt, focus and other

parameters.
Perform the following steps to add a preset:

1.

a > w D

Click the Preset button to enter the PTZ preset configuration panel.

Click the direction buttons on the PTZ control panel to steer the camera to the desired view.
Select a PTZ preset number from the preset list and click .

Input the name of the preset in the pop-up dialog box.

Click OK to save the settings.

To call a configured preset, double-click the preset, or select the preset and click the icon .

To modify a configured preset, select the preset from the list and click the icon .

To delete a configured preset, select the preset from the list and click the icon ﬂ

PTZ Contral v

Add Preset

02 Preset2
03 Preset3
04 Presets
05 Presets

Configuring the Pattern

A pattern is a memorized, repeating series of pan, tilt, zoom, and preset functions.
Perform the following steps to add a pattern:

a rc v e

—

b

N

Click the Pattern button to enter the PTZ pattern configuration panel.

Click B to start recording of this pattern path.
Use the direction buttons to control the PTZ movement.

Click H to stop and save the pattern recording.
Click the icon . to call the pattern. To stop calling the pattern, click !

Only one pattern can be configured, and the newly-defined pattern will overwrite the previous
one.
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Configuring the Patrol

PTZ Control v

“ B e W I:
Preset F'arleﬁE Patrol
il 0%

A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed

between two presets and the dwell time at the preset separately programmable.

Before you start:

Two or more presets for one PTZ camera need to be added.

Perform the following steps to add and call a patrol:

© 0 M w D E

512
[[Nore]

Click the Patrol button to enter the PTZ patrol configuration panel.
Select a track number from the drop-down list.

Click == to add a preset, and set the dwell time and patrol speed for the preset.
Repeat the above operation to add other presets to the patrol.

Optionally, you can click # or I to edit or delete a preset in the patrol path.
Click the icon ! to call the patrol. To stop calling the patrol, click ™.

® Up to 16 patrols can be configured.

® The preset dwell time can be set to 1~255 sec, and the patrol speed can be set to level 1~40.
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PTZ Contral v

- = - o
ELDOEN
_Preset | Patten | Patrol
Preset: Preset] -
a2 Dwell Time(s) | 1 .
Patrol Speed: 1 :

2.4.4 Manual Recording and Capture

Toolbar in Each Live View Display Window:

In each live view display window, the following toolbar buttons are available:

Capture Capture the picture in the live view process.

- Start/Stop Recording  Start/Stop manual recording. The record file is stored in the PC.
Switch to Instant . )

H Switch to the instant playback mode.

Playback

Manual Recording in Live View

Purpose:

Manual Recording function allows you to record the live video on the Main View page manually and

the record files are stored in the local PC.

Steps:

1. Move the mouse pointer to the display window in live view to show the toolbar.

2. Click - in the toolbar of the display window or on the right-click Live View Management Menu
to start the manual recording. The icon - turns to H

3. Click theicon ﬂ to stop the manual recording.
A prompt box with the saving path of the video files you just recorded will pop up if all the
operations succeed.

=

vore]

® During the manual recording, an indicator E appears in the upper-right corner of the display
window.

® The saving path of video files can be set on the System Configuration interface. For details, see
Section 7.2.2 File Saving Path Settings.
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Viewing Local Record Files

Steps:

1. Click File->Open Video File to open the Record Files page.

2. Select the camera to be searched from the Camera Group list.

3. Click the icon E= to specify the start time and end time for the search.

4. Click Search. The video files recorded between the start time and end time will be displayed.
Select the video file, and click Delete. You can delete the video file.
Select the video file, and click Email Linkage. You can send an Email notification with the selected
video file attached.
Select the video file, and click Save as. You can save a new copy of the video file.

£
[Noe}

To send an Email notification, the Email settings need to be configured before proceeding. For
details, see Section 7.2.5 Email Settings.

Brverse Recosd Files .

Camera Group Vioen Files € Delee Emall Linkaga(Wac=5M8) & Saveas

Start Time:
2013-05-27 00-00:00 et
End Time:
2013-05-27 235953 [ied

Q search

13

Double-click the video file and the video file can be played back locally.

.

00:00:07/00:12:30
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The following buttons are available on the local playback page:

B B0 crF/acrF Display the video in cif/4cif resolution.

E Full Screen Display the local playback page in full screen mode.
Close Close the local playback page of the record files.

Ll Bey| Pause/Play Pause/Start the playback of the record files.

[ Stop Stop the playback of the record files.

[ Speed Set the playback speed.

[ Single Frame Play back the record files frame by frame.

Q| Digital Zoom Enable the digital zoom function. Click again to disable.
[z L4l Enable/Disable Audio  Click to enable/disable the audio in the local playback.
| m21 Capture Capture the picture in the playback process.

Capturing Picture in Live View

Steps:

1. Move the mouse pointer to the display window in live view to show the toolbar.

2. Click the icon in the toolbar of the display window or on the right-click Live View
Management Menu.
A small window of the captured picture will be displayed to notify whether the capturing
operation is done or not.

=
o]

The saving path of the captured pictures can be set on the System Configuration interface. For
details, see Section 7.2.2 File Saving Path Settings.

Viewing Captured Pictures

The pictures captured in live view are stored in the PC running the software. You can view the
captured pictures if needed.
Steps:

1.

a ~w D

Click File->Open Captured Picture to open the Captured Picture page.

Select the camera to be searched from the Camera Group list.

Click the icon 8 to specify the start time and end time for the search.

Click Search. The pictures captured between the start time and end time will be displayed.
Double-click the captured picture to enlarge it for a better view.

Select the captured picture, and click Print. You can print the selected picture.

Select the captured picture, and click Delete. You can delete the selected picture.

Select the captured picture, and click Email Linkage. You can send an Email notification with the
selected picture attached.

Select the captured picture, and click Save as. You can save a new copy of the selected picture.
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Dipen Caphirad Pipfurs: »
Camera Group Local Caplure. &=, Print. © Delete Emall Linkage{Max =SNE), Save ag
— IO
1 1Ped
& [PC1_Camerat

= Nl vl
+ T DW
‘Stat Time:

20120209 T0.0090 =
End Timie
201365032359 59 1!

Q, seamh

2.4.5 Instant Playback

Purpose:

The record files can be played back instantly on the Main View page. Instant playback shows a passage

of the video which was remarkable, or which was unclear on the first sight. Thus, you can get an

immediate review if needed.

Before you start:

The video files need to be recorded on the storage devices, such as the SD/SDHC cards and HDDs on

the DVRs, NVRs, Network Cameras, etc., or on the storage servers.

Steps:

1. Start the live view and move the mouse pointer to the display window to show the toolbar.

2. Click the icon in the toolbar and a list of time periods pops up.
30s, 1 min, 3 min, 5 min, 8 min, and 10 min are selectable.

3. Select a time period to start the instant playback.
Example: If the current time of the live view is 09:30:00, and you select 3 min, then the instant
playback will start from 09:27:00.

4. Click theicon again to stop the instant playback and go back for the live view.

g

4 NOTE]|

® During the instant playback, an indicator appears in the upper-right corner of the display
window.

® The live view process will continue after the instant playback completed.
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Right-click on the display window to open the Instant Playback Management Menu:

Il Pause

W Sitop

M SpeedUp

44 SpeedDown

I+ Single Frame

@, Open Digital Zoom

Lis Capture

= Print Captured Picture
57 Send Email

B StartRecording

ly2 Enable Audio

% Switch to Live View

Full Screen

The following buttons are available on the right-click Instant Playback Management Menu:

EEEC& AN MalRPF¥ T

4

Iy

Pause/Play

Stop

Speed Up/Down
Single Frame

Open Digital Zoom
Capture

Print Captured Picture

Send Email

Start/Stop Recording
Enable/Disable Audio
Switch to Live View
Full Screen

Pause/Start the instant playback in the display window.

Stop the instant playback and return to the live view mode.
Increase/Decrease the play speed of the instant playback.

Play back the record file frame by frame.

Enable the digital zoom function. Click again to disable the function.
Capture the picture in the instant playback process.

Capture the current picture and then print the picture.

Capture the current picture and then send an Email notification to
one or more receivers. The captured picture can be attached.
Start/Stop clipping the record files.

Click to turn on/off the audio in instant playback.

Switch to live view mode.

Display the instant playback in full screen mode. Click again to exit.
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2.4.6 Other Functions in Live View

There are some other functions supported in the live view, including digital zoom, two-way audio,
camera status and synchronization.

Aucxiliary Screen Preview

The live video can be displayed on different auxiliary screens for the convenient preview of multiple
monitoring scenes. Up to 3 auxiliary screens are supported.

Digital Zoom

Use the left key of mouse to drag a rectangle area in the lower-right/upper-left direction, and then the
rectangle area will zoom in/out.

Two-way Audio

Two-way audio function enables the voice talk of the camera. You can get not only the live video but
also the real-time audio from the camera. This two-way audio can be used for only one camera at one
time.

Camera Status

The camera status, such as recording status, signal status, connection humber, etc., can be detected
and displayed for check. The status information refreshes every 10 seconds.

Synchronization

The synchronization function provides a way to synchronize the live video clock with the PC which
runs the client software.
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Chapter 3 Remote Record Schedule Settings
and Playback

When the video storage devices are the HDDs, Net HDDs, SD/SDHC cards on the local device, or the
remote storage server connected, you can set the record schedule for the cameras for the continuous,
alarm triggered or command triggered recording. And the record files can be searched for the remote
playback.

3.1 Remote Recording

Purpose:
The video files can be recorded on the HDDs, Net HDDs, SD/SDHC cards on the local device, or the
storage server connected.

8
Click the ==/ icon on the control panel,

or click Tool->Record Schedule to open the Record Schedule page.

Camara Groug Recard Sthaiuls G fo: I 53

Locdl Recording
IPC1-Encading Cranne|
# Hacord Schadula Al-gay Templats - Edi Scharced Betings
MVR-Encrding Channel
A ¢ Caphurs Schedule: Tampiata 01 - Edt AhErced Senngs
‘C2-Ens

GVR-Encoding Ghanns!
2] Storaga Senar Hecaraing
& DVR_Camera2

& DVR_Camaralz

& DVR_Cameratl

& DVR_IF Gamema12

3.1.1 Recording on Storage Devices on the DVRs, NVRs, or

Network Cameras

Purpose:

Some local devices, including the DVRs, NVRs, and Network Cameras, provide storage devices such as
the HDDs, Net HDDs and SD/SDHC cards for record files. You can set a record schedule or capture
schedule for the channels of the local devices.
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;=
l NOTE|
The pictures captured through the capture schedule are stored on the local device and can be
searched on the remote configuration page of the device.
Before you start:
The newly installed storage devices need to be formatted. Go to the remote configuration page of the
device, click Storage->General, select the HDD or SD/SDHC card, and click Format to initialize the
selected storage device.
Steps:
1. Open the Record Schedule page.
2. Select the camera in the Camera Group list.
3. Check the checkbox Record Schedule under Local Recording to enable device local recording.
4. Select the record schedule template from the drop-down list.
All-day Template: for all-day continuous recording.
Weekday Template: for working-hours continuous recording from 8:00 AM to 8:00 PM.
Alarm Template: for motion detection or alarm input triggered recording.
Template 01-08: fixed templates for specific schedules. You can edit the templates if needed.
Custom: can be customized as desired.
If you need to edit or customize the template, see Configuring Record Schedule Template.
5. Click Advanced Settings to set the recording parameters. For details, see Table 3-1 Advanced
Recording Settings.
6. Optionally, click Copy to... to copy the record schedule settings to other channels.
7. Click Save to save the settings.

Pre-record: 55 v
Postrecord: BS [
Video Expired Time: 0 day(s)
Redundant Record: No [
Record Audio: Yas v

Table 3-1 Advanced Recording Settings

Parameters Descriptions

Normally used for the event triggered record, when you want to record before
Pre-record

the event happens
Post-record After the event finished, the video can also be recorded for a certain time.

The time for keeping the record files in the storage device, once exceeded, the

Video Expired Time . . . ) . .
files will be deleted. The files will be saved permanently if the value is set as 0.

Redundant Record | Save the video files not only in the R/W HDD but also in the redundant HDD.

Record Audio Record the video files with audio or not.
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Configuring Record Schedule Template

Perform the following steps to configure the record schedule template:

If Template 01-08 is selected from the drop-down list, start from step 1;

If Custom is selected from the drop-down list, start from step 2.

1. Click Edit to enter the Templates Management interface. Select the template to be set and you
can edit the template name.

2. Set the time schedule for the selected template.

# Schedule Recording refer to normal schedule recording. The schedule time bar is greenyellow.
£ Marm Recording refers to the schedule record for the alarm input or motion detection event. The

schedule time bar is red.

£ Command | refers to the schedule record triggered by command. The schedule time bar is

green.

o
[nore]

Record triggered by command is only available for the ATM transactions when the ATM DVR
is added to Safire Control Center.

When the cursor turns to ﬁg‘;, you can edit the schedule time bar.
When the cursor turns to l---.ﬁ, you can move the selected time bar you just edited.
When the cursor turns to LS, you can lengthen or shorten the selected time bar.

3. Optionally, you can select the schedule time bar,
and then click the icon ' *  to delete the selected time bar,
or click theicon B to delete all the time bars,
or click the icon to copy the time bar settings to the other dates.
4. Click OK to save the settings.
You can click Save as Schedule Template on the Custom Schedule interface, and then the custom
template can be saved as template 01--08.

.

4 NOTE(

Up to 8 time periods can be set for each day in the record schedule.

Tempiates Managameanl ®
All-dzy Tamplats # schedile Recoring & MarmRacordng £ Command S
‘Weekday Templ...
i 13 L; 1 1£ 1% 1a 18 a 2 o
. ; :
Aarm Template st
o 2 1 B E 1 L2 it ji3 18 o 2 k2
Tempizte 01| ST
Ternglale 02 T i £ E 10 17 13 & 1 T =4
wed : :
Termplate 13
i & 1 1 1
Temalate 14 L
= i D e 1 il 1
Tamplate 15 i
Templats 16 d L i e ; 2 1
3a
Temalale 07
) u. .b 1 8 1
Templats 03 B
ok |
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Custom Schedule =

ecule Recarding. & Alarm Recording. | 4 Command X I Save as Schedule Templats

Thu

Fri

Sat

3.1.2 Recording on Storage Server

Purpose:

The storage server performs as a NVR installed on the PC. The record files can be stored in the storage
server and you can search the files for remote playback.

Before you start:

The storage server application software needs to be installed and it is packed in the Safire Control
Center software package. When installing the Safire Control Center, check the checkbox Storage
Server to enable the installation of storage server.

Adding the Storage Server

Steps:

1. Click the shortcut icon i
P
o]

on the desktop to run the storage server.

You can also record the video files on the storage server installed on other PC.
Open the Device Management page and click the Server tab.
Click Add New Device Type, select Storage Server and click OK.
Click Storage Server on the list to enter the Storage Server Adding interface.
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You can add the storage server in the following ways:

® By detecting the online devices, see Section 2.2.1 Adding Online Devices.

® By specifying the device IP address, see Section 2.2.2 Adding Devices Manually.
® By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment.
® By IP Server, see Section 2.2.4 Adding Devices by IP Server.

Formatting the HDDs

The HDDs of the storage server need to be formatted for the record file storage.

Steps:

1. Select the added storage server from the list and click Remote Config.

2. Click Storage->General, to enter the HDD Formatting interface.

3. Select the HDD from the list and click Format. You can check the formatting process from the
process bar and the status of the formatted HDD changes from Unformatted to Normal Status.

=
[[Nore]
Formatting the HDDs is to pre-allocate the disk space for storage and the original data of the

formatted HDDs will not be deleted.

HDD settings.

(™ HDD MNo. | Capacity(MB) | Free Space (. | Stalus Type Group No. Property

H 1 321 1411 Unformatted  Local GrouglQ ReadiVrite
[ 2 40479 40389 Unformatted  Local GrouplQ Readirite
3 3348906 297082 Unformatted  Local Groupo Readiyrite
04 15959 7245 Unformatted  Local Groupo Readivrite
Os 1997294 546729 Unformatted  Local Groupli) Read\Write

Format | | UpdateAl

0%

Configuring Storage Server Record Schedule
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Before you start:
The storage server needs to be added to the client software and the HDDs need to be formatted for
the record file storage.
Steps:

Open the Record Schedule page.

1.

a b~ D

o

Select the camera from the Camera Group list.

Check the checkbox Storage Server to enable recording on storage server.

Select the storage server from the drop-down list.

Select the record schedule template from the drop-down list.

If you need to edit or customize the template, see Configuring Record Schedule Template.
Click Advanced Settings to set the pre-record time, post-record time and video expired time.

Click Save to save the settings.

3.2 Remote Playback

Purpose:
The record files stored on the local device or the storage server can be searched by custom view,

camera or triggering event, and then can be played back remotely.

Click the ! icon on the control panel,

or click View->Remote Playback to open the Remote Playback page.

Vigw
Camera

Event

Motion Detechion

JIPCH

& PC1_Cameral

— NVR
HIPCZ

I VR

Alarm nput

More Search Options

3 —

Remote Playback Page

13514 | 15
20 21 22

26 (2T 28

i)

#__ —
Al e e 2 de &g@

1 View List, Camera List and Event List

2 Calendar
3 Search Options

4 Search Result List
5 Display Window of Playback
6 Playback Toolbar

5
6
7
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7 Timeline

3.2.1 Normal Playback

Purpose:
The record files can be searched by custom view or camera for the Normal Playback.

Searching Record Files for Normal Playback

Steps:

1. Open the Remote Playback page.

2. Click ™ toexpand the View List or Camera List on the left-side.

3. Select the view or camera to be searched from the list.

4. Select the day to be searched on the calendar.
You can also click ¥ to show more search options, and then click the icon ﬂ to specify the
start time and end time for the search.

5. Click Search. The record files of the selected view or camera will be displayed on the Search

Result list. You can filter the results through the Filter text field.
o

NoTe

® You can also search the record files by the card number (only applicable to ATM DVR) or by the
file type.
® If there are record files for that camera in that day, in the calendar, the icon for that day is

displayed as .. Otherwise it is displayed as  '® .
® Up to 16 cameras can be searched simultaneously.
Search Result v
Filter

- @ DVR_Cameral
ﬁ 2013-06-27 00:00:00

B 2013-06-27 06:36:57

Normal Playback

After searching the record files for the normal playback, you can play back the record files in the
following two ways:
®  Playback by File List
Click the icon 2 in the toolbar to start the playback from the first record file;
or double-click the record file on the search result list to play the selected video.
®  Playback by Timeline
The timeline indicates the time duration for the record file, and the record files of different types
are color coded. Click on the timeline to play back the video of the specific time.

You can click k=== or === to scale up or scale down the timeline bar.

You can click '€ or ' to go to the previous or the next time period.
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You can use the mouse wheel to zoom in or zoom out on the timeline.

Normal Playback Toolbar:

On the Normal Playback page, the following toolbar buttons are available:
== =5  Async/Sync Playback Click to play back the record files synchronously/asynchronously.

—.* ——

L} Stop Playback Stop the playback of all cameras.

(Il B Pause/start Playback Pause/Start the playback of the record files.

LS Single Frame Play back the record files frame by frame.

|2 &) Volume Click to turn on/off the audio and adjust the audio volume.

(L Full Screen Display the video playback in full screen mode. Press ESC to exit.
=

1 NOTE}

You can move the slider on the Playback Speed Bar to set the playback speed.

3.2.2 Event Playback

Purpose:
The recordings triggered by motion detection or alarm input can be searched for Event Playback and
this function requires the support of the connected device.

Searching Record Files for Event Playback

Steps:
1. Open the Remote Playback page.
2. Click ™ to expand the Event List on the left-side.
3. Click Motion Detection or Alarm Input, and select the cameras or alarm input sensors.
4. Select the day to be searched on the calendar.
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You can also click ¥ to show more search options, and then click the icon E_E to specify the
start time and end time for the search.

5. Click Search. The recordings from the selected cameras and sensors triggered by motion
detection or alarm input will be displayed on the Search Result list.

Event Playback

After searching the recordings triggered by the event, you can play back the record files in the
following two ways:
®  Playback by File List
Select the record file from the search result list, and then click the icon 2 in the toolbar,
or double-click the record file to play the video on the display window of playback.
®  Playback by Timeline
The timeline indicates the time duration for the record file. Click on the timeline to play back the
video of the specific time.

You can click k=== or k=== to scale up or scale down the timeline bar.

You canclick '€ or ' * ' togo to the previous or the next time period.
You can use the mouse wheel to zoom in or zoom out on the timeline.

Event Playback Toolbar:

On the Remote Playback page, the following toolbar buttons are available:

L} Stop Playback Stop the playback of all channels.

(Il B Pause/start Playback Pause/Start the playback of record files.

. Single Frame Play back the record files frame by frame.

- Previous Event Go to the playback of the previous event.

=» Next Event Go to the playback of the next event.

42 &) Volume Click to turn on/off the audio and adjust the audio volume.

(L Full Screen Display the video playback in full screen mode. Press ESC to exit.
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You can move the slider on the Playback Speed Bar to set the playback speed.

3.2.3 Synchronous Playback

Purpose:
In synchronous playback, the record files can be played back in synchronization.

!;:
nore]

Record files from up to 16 cameras can be played back simultaneously.

Synchronous Playback for Some Searched Cameras

Steps:

1. Start the normal playback of the searched cameras.

2. Click == in the toolbar, and then the record files in normal playback will be played in sync. The
icon =& turnsto =,

3. To disable the synchronous playback, click the icon =

Synchronous Playback for All Searched Cameras

Steps:
1. Search the record files for the normal playback.
2. Click 22 in the toolbar to enable the synchronous playback. The icon == turnsto =

3. Select the record file from the list and click K2,
or click on the timeline to start the synchronous playback for all searched cameras.

4. To disable the synchronous playback, click the icon =
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Chapter 4 Event Management

Purpose:

In Safire Control Center client software, rules can be set up for triggers and linkage actions. You can
assign linkage actions to the trigger by setting up a rule. For example, when motion is detected, an
audible warning appears or other linkage actions happen.

Click the & icon on the control panel,
or click Tool->Event Management to open the Event Management page.

W CemeEvial B Namnput- (% Desics Excaption
Camera Groug SelectEvent Trpe. Mation Detaction - IPC2_Camera Everk Configur... Coprio. i san
7 Enade
- IPC1-Encading Channel Aming Schadule Ait-day Template . Eat
& IPC1_Cameral Aming Region
MVR-Encading Channel
PC2-Encodng Channel

DAR-Encoding Channgl

Trigoer Alarm Oulput Trigger Channel Rece(d o Trigaer Client Actlen
Camerst o AuGTiE Waming
v Email Linkage
< Alam on E-map

¥ Aarm Triggered Pop-up Image

You can set different linkage actions for the following triggers:
Motion Detection

Tampering Alarm

PIR Alarm

Video Loss

Alarm Input

Device Exception

4.1 Configuring Motion Detection Alarm

Purpose:

A motion detection alarm is triggered when the client software detects motion within its defined area.
The linkage actions, including alarm output, channel record and client action can be set.

Steps:

1. Open the Event Management page and click Camera Event tab.

2. Select the camera to be configured and select Motion Detection as the event type.

3. Check the checkbox Enable to enable the function of motion detection.

4. Select the arming schedule template from the drop-down list.
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All-day Template: for all-day continuous arming.

Weekday Template: for working-hours continuous arming from 8:00 AM to 8:00 PM.

Template 01-09: fixed templates for special schedules. You can edit the templates if needed.
Custom: can be customized as desired.

If you need to edit or customize the template, see Configuring Arming Schedule Template.
Click-and-drag the mouse to draw a defined area for the arming region.

You can click the icon 2 to set the whole video area as detection area, or click the icon HI to
clear all the detection area.

Drag the slider on the sensitivity bar to adjust the motion detection sensitivity. The larger the
value is, the more sensitive the detection is.

Check the checkboxes to activate the linkage actions. For details, see Table 4-1 Linkage Actions for
Motion Detection Alarm.

Optionally, click Copy to... to copy the event parameters to other channels.

Click Save to save the settings.

Seled Event Type Mation Detaction ~ IPC2_Camerat Event Configur Capy .

o save
2 Enabla

Arming Schedule: All-day Template

Arming Reglon

Trigger Alarm Output Tngger Channel Record  Tngger Client Action

Camerad1 . Audible Warning
+ Email Linkage

¥ Alarm on E-map

¥ Alarm Triggered Pop-up image

Table 4-1 Linkage Actions for Motion Detection Alarm

Linkage Actions Descriptions

Enable the alarm output function. Select the alarm output port and the

Alarm Output .
external device connected to the port can be controlled.

Channel Record

Start the recording of the selected cameras when alarm is triggered.

Audible Warning

The client software gives an audible warning when alarm is triggered.

Email Linkage

Send an Email notification of the alarm information to one or more receivers.

Alarm on E-map

Display the alarm information on the E-map.

Alarm Triggered
Pop-up Image

The Image with alarm information pops up when alarm is triggered.

Alarm Triggered
Video Wall Display

Display the video on the Video Wall when alarm is triggered.
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Configuring Arming Schedule Template

Perform the following steps to configure the arming schedule template:
If Template 01-09 is selected in the drop-down list, start from step 1;

If Custom is selected in the drop-down list, start from step 2.

Steps:

1.

Click Edit to enter the Templates Management interface. Select the template to be set and you
can edit the template name.

Set the time schedule for the selected template.

When the cursor turns to , you can edit the schedule time bar.

When the cursor turns to -"5', you can move the selected time bar you just edited.

When the cursor turns to -}9, you can lengthen or shorten the selected time bar.
Optionally, you can select the schedule time bar,

and then click theicon ' * ' to delete the selected time bar,

or click theicon B to delete all the time bars,

or click the icon to copy the time bar settings to the other dates.

Click OK to save the settings.

You can click Save as Schedule Template on the Custom Schedule interface, and then the custom
template can be saved as template 01--09.

P

[Nore}

Up to 8 time periods can be set for each day in the arming schedule template (depending on the
capacity of device).

Tempistas Mansgamanl ®

Al Tamplats ol
‘Weskday Templ....
Temaae 12 s
Temglale 03 1 T 4 & E 10 1z b1S 6 1 o ]
Termplate (14

Template 05

i o D e 1 20 1
Tarmglate 18 i
Template 17 A W i © 1 2 1
3a
Temglate 02
) o u. e 1 20 4
Template 09 B
[ ok
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4.2 Configuring Tampering Alarm

Purpose:

A tampering alarm is triggered when the camera is covered and the monitoring area cannot be viewed.

The linkage actions, including alarm output and client action can be set.
Steps:

1.

2.
3.
4

9.

Open the Event Management page and click the Camera Event tab.

Select the camera to be configured and select Tampering Alarm as the event type.

Check the checkbox Enable to enable the function of tampering alarm.

Select the arming schedule template from the drop-down list.

If you need to edit or customize the template, see Configuring Arming Schedule Template.
Select the triggered camera. The image or video from the triggered camera will pop up or be
displayed on the Video Wall when tampering alarm occurs.

Click-and-drag the mouse to draw a defined area for the arming region.

Drag the slider on the sensitivity bar to adjust the tampering alarm sensitivity.

Check the checkboxes to activate the linkage actions. For details, see Table 4-2 Linkage Actions for
Tampering Alarm.

Optionally, click Copy to... to copy the event parameters to other cameras.

10. Click Save to save the settings.
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Seled Event Type Tampering Alarm ~ | IPC2_Camerat Event Gonfigur Capylo. o save

2 Enabla
Arming Schedule: All-day Template - Edit

Trigger Camera: v

Arming Region

Trigger Alarm Output + Tngger ClientAction
el o9

 Audibie Warning
¥ EmallLinkage
| Alarmon E-map

¥ Alarm Tnggered Pop-up Image

Table 4-2 Linkage Actions for Tampering Alarm

Linkage Actions

Descriptions

Alarm Output

Enable the alarm output function. Select the alarm output port and the
external device connected to the port can be controlled.

Audible Warning

The client software gives an audible warning when alarm is triggered.

Email Linkage

Send an Email notification of the alarm information to one or more receivers.

Alarm on E-map

Display the alarm information on the E-map.

Alarm Triggered
Pop-up Image

The Image of the triggered camera pops up when alarm is triggered.

Alarm Triggered
Video Wall Display

Display the video of the triggered camera on the Video Wall when alarm is
triggered.

4.3 Configuring PIR Alarm

Purpose:

A PIR (Passive Infrared) alarm is triggered when an intruder moves within the detector's field of view.
The heat energy dissipated by a person, or any other warm blooded creature such as dogs, cats, etc.,

can be detected.

!{.:
o]

The PIR Alarm function requires the support of connected device.

Steps:

1. Open the Event Management page and click the Camera Event tab.

2. Select the camera to be configured and select PIR Alarm as the event type.
3. Check the checkbox Enable to enable the function of PIR alarm.

4. Input a descriptive name of the alarm.
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Check the checkboxes to activate the linkage actions. For details, see Table 4-3 Linkage Actions for
PIR Alarm.

Optionally, click Copy to... to copy the event parameters to other channels.

Click
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Select the arming schedule template from the drop-down list.

If you need to edit or customize the template, see Configuring Arming Schedule Template.

Select the triggered camera. The image or video from the triggered camera will pop up or be
displayed on the Video Wall when video loss alarm occurs.

Check the checkboxes to activate the linkage actions. For details, see Table 4-4 Linkage Actions for
Video Loss Alarm.

Optionally, click Copy to... to copy the event parameters to other cameras.

Click Save to save the new settings.

Select Event Type |videa Lass « [ IPC2_Cameral Event Ganfigur Capyfo. i save
4 Enable
Arming Schedule: All-day Templzle - Edif
Trigger Camera:
Trigger Alarm Outgut 4 Tngger ClientAdtion

) Audible Waming

# Email Linkage
+ Alarm on E-map

' Alarm Tnopgered Pop-up Image

Table 4-4 Linkage Actions for Video Loss Alarm

Linkage Actions Descriptions

Enable the alarm output function. Select the alarm output port and the

Alarm Output .
external device connected to the port can be controlled.

Audible Warning The client software gives an audible warning when alarm is triggered.

Email Linkage Send an Email notification of the alarm information to one or more receivers.

Alarm on E-map Display the alarm information on the E-map.

Alarm Triggered The Image of the triggered camera pops up when alarm is triggered.
Pop-up Image

Alarm Triggered Display the video of the triggered camera on the Video Wall when alarm is
Video Wall Display | triggered.

4.5 Configuring Alarm Input Linkage

Purpose:

When a device's alarm input port receives a signal from an external alarm device, such as smoke
detector, doorbell, etc., the alarm input linkage actions are triggered for notification.

Before you start:
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Add the alarm inputs to the client, click Import on the Group Management interface, click the Alarm
Input tab and import alarm inputs into groups for management.

Steps:

Open the Event Management page and click the Alarm Input tab.

Select the alarm input channel to be configured.

Check the checkbox Enable.

Input a descriptive name of the alarm.

Set the alarm status according to the alarm input device.

Select the arming schedule template from the drop-down list.

If you need to edit or customize the template, see Configuring Arming Schedule Template.

7. Check the checkboxes to activate the linkage actions. For details, see Table 4-5 Linkage Actions for

© ok~ w bR

Alarm Input.
Optionally, click Copy to... to copy the event parameters to other alarm inputs.
Click Save to save the settings.

DVA_A1 Event Gonfiguration Copyto.. K save
~ Enable
Alarm Mame:
Alarm Etatus: o Mormal Open Mormal Closed
Amming Schadule: Al-day Template - Edit
Triggerdlarm Ouipul Trigger Shannel Record E # Trigger Client Action
A1 Camerall < Audible Waming
LS Cameralz < Emal Linkage
A3 Cameral3 ¥ Alarm on E-map

Aerd Cameral4

<

Marm Triggered Pop-up Image
Camerads
Cameradgé
Cameral7
Cameralg
Cameradg
Camerall
Cameraii
Cameral2
Camerals
Camerald
Camerals

Cameralg

Table 4-5 Linkage Actions for Alarm Input

Linkage Actions Descriptions

Enable the alarm output function. Select the alarm output port and the
Alarm Output .
external device connected to the port can be controlled.

Channel Record Start the recording of the selected cameras when alarm is triggered.

Audible Warning The client software gives an audible warning when alarm is triggered.

Email Linkage Send an Email notification of the alarm information to one or more receivers.

Alarm on E-map Display the alarm information on the E-map.

Alarm Triggered The Image with alarm information pops up when alarm is triggered.

Pop-up Image

Alarm Triggered Display the video on the Video Wall when alarm is triggered.
Video Wall Display
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4.6 Configuring Device Exception Linkage

Steps:

1. Open the Event Management page and click the Device Exception tab.

Select the device to be configured.

2

3. Select the device exception type, including HDD full, HDD exception, illegal login, etc.

4. Check the checkbox Enable.

5. Check the checkboxes to activate the linkage actions. For details, see Table 4-6 Linkage Actions for

Device Exception.

6. Optionally, click Copy to... to copy the event parameters to other devices.
Click Save to save the settings.
DVR Event Configuration Copyto.. K save
Exception Type: HDO Full w
< Enable
Linkage Action

TriggerAlarm Cutput -# Trigger Clieni Action

A1
A-=2
A3
A

- Auditle Warning

/' Email Linkage

Table 4-6 Linkage Actions for Device Exception

Linkage Actions

Descriptions

Alarm Output

Enable the alarm output function. Select the alarm output port and the
external device connected to the port can be controlled.

Audible Warning

The client software gives an audible warning when alarm is triggered.

Email Linkage

Send an Email notification of the alarm information to one or more receivers.

4.7 Viewing Alarm and Event Information

The information of recent alarms and events can be displayed. Click the icon H in Alarms and Events
Toolbar to show the Alarms and Events panel.
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a I B ds el account s confgured and i he sending operalions are siopped
Index = Alarm Time Alarm Source Alarm Detalls Alarm Content Lwveflew SendE. | Nole
8
1 2013-06-2815:5736  Encoding Dewvics| PC2 Camera: (PC2 Camarat Tngoer.. Mation Detschon Alarm Start L*] |I
Aarm Ewnl - Mation Detechion .~ Video Exceplion .~ Alarm Input .~ Device Excaption

On the Alarms and Events panel, the following toolbar buttons are available:

]

o]
o]
2]

Clear Info Clear the information of alarms and events displayed on the list.
Enable/Disable Alarm

Triggered Pop-up Click to enable/disable image pop-up when alarms occur.
Image

n Enable/Disable Audio  Click to enable/disable the audio warning for the alarm.

n Auto Hide/Lock Click to hide automatically/lock the Alarms and Events panel.
Maximize Maximize the Alarms and Events panel in a new tab page.

H Show/Hide Click to show/hide the Alarms and Events panel.

Viewing Alarms Information

Different alarm types can be displayed on the panel: Motion Detection, Video Exception, Alarm Input
and Device Exception. You can check the checkbox to enable the displaying of that type alarm.

Before you start:

To display the alarms, the event parameters need to be configured.

Steps:

1. Click the Alarm tab.

2. Check the checkboxes of different alarm types.

3.  When an alarm occurs, the icon E twinkles to call attention. The alarm information, including
the time, source, details and content will be displayed.
Click % to get a live view of the alarm triggered camera.
Click ' to send an Email notification of the alarm to one or more receivers.
Click 5] to display the video of alarm triggered camera on the Video Wall. This function is only
available when the decoding device is added.
Click under the Note column to input a prompt message for the alarm.

4. To clear the alarm information, click the icon H or right-click on an alarm log and then click

Clear.

Viewing Events Information

Purpose:

The abnormal events of the client software, such as the live view failure, device disconnection, can

also be displayed.

Steps:

1.

Click the Event tab.
The event information, including the time and detailed description will be displayed.

To clear the event information, click the icon H or right-click on the event log and then click
Clear.

48



User Manual of Safire Control Center

49



User Manual of Safire Control Center

Chapter 5 E-map Management

Purpose:

The E-map function gives a visual overview of the locations and distributions of the installed cameras
and alarm input devices. You can get the live video of the cameras on the map, and you will get a
notification message from the map when alarm is triggered.

=
Click the icon on the control panel,

or click View->E-map to open the E-map page.

| O O

NR.
FC2

uap Predew | EdfMap 4 ot £ e i £

E-map Page
1 Group List
2 Map Display Area
3 E-map Toolbar

5.1 Adding an E-map

Purpose:

An E-map needs to be added as the parent map for the hot spots and hot regions.
Steps:

1. Open the E-map page.

2. Select a group for which you want to add a map.

3. Clicktheicon ‘& in the Map Display Area to open the map adding dialog box.
4. Input a descriptive name of the added map as desired.

5. Click theicon | and select a map file from the local path.

6. Click OK to save the settings.
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® The picture format of the map can only be *.png, *.jpg or *.bomp.
® Only one map can be added to a group.

E-map Info x

Map Name: Main Mapl
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The map added is displayed in the Map Display Area. Use the mouse wheel to zoom in or zoom out on
the map. You can click-and-drag the yellow window in the lower-right corner or use the direction
buttons and zoom bar to adjust the map area for view.
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Click the button Edit Map or Map Preview in the E-map toolbar to enter the map editing mode or
map preview mode.
E-map Toolbar in Map Editing Mode:

e | Eoiltiap ‘¥a R

Iap Praview

On the E-map page, the following toolbar buttons are available:

7 Modify Map Modify the map information, including the map name and file path.
m Delete Map Delete the current map.

[ﬂ Add Camera Add a camera as the hot spot on the map.

Add Alarm Input Add an alarm input sensor as the hot spot on the map.
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Add Hot Region Add a map as the hot region on the current map.

Modify Modify the information of the selected hot spot or hot region.
Delete Delete the selected hot spot or hot region.

Clear Alarm Info Clear the alarm information displayed on the map.

Back to Parent Map  Go back to the parent map.

5.2 The Hot Spot Function

Purpose:

The cameras and alarm inputs can be added on the map and are called the hot spots. The hot spots

show the locations of the cameras and alarm inputs, and you can also get the live video and alarm

information of the surveillance scenarios through the hot spots.

5.2.1 Adding Hot Spots

Adding Cameras as Hot Spots

Steps:
Click the Edit Map button in the E-map toolbar to enter the map editing mode.

Click the icon &l in the toolbar to open the Add Hot Spot dialog box.
Check the checkboxes to select the cameras to be added.

1.

a b~ N

Optionally, you can edit hot spot name, select the name color and select the hot spot icon.

Click OK to save the settings. The camera icons are added on the map as hot spots and the icons

of added cameras changes from @10 € in the group list. You can click-and-drag the camera

icons to move the hot spots to the desired locations.

You can also click-and-drag the camera icons from the group list to the map directly to add the

hot spots.
Linked Camera Hol Spot Mame Haot Spat Color Hol Spetlcon
DVR_Cameral DVR_Cameral B creen @
DVR_Carmera2 DVR_Camera2 & G &
DVR_Carmera3 DVR_Cameral o Grean a
DVR_Camerad DVR_Camerad & Green (&
DVR_Cameras OVA_Cameras @ creen &
DWFR_Camerss DWR_Cameras W creen @&
DVR_Camera? DVR_Camera? W Green @
DWR_Cameraf DWR_Camerad W Gresn @
DWR_Camerad DVR_Camerad W oGreen @
DVR_Camera1l DVR_Camerall B Green @
DVR_Camerail DVR_Cameratl B Grean @

Adding Alarm Inputs as Hot Spots

Steps:
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a > N PP

Click the Edit Map button in the E-map toolbar to enter the map editing mode.

Click the icon @ in the toolbar to open the Add Hot Spot dialog box.

Check the checkboxes to select the alarm inputs to be added.

Optionally, you can edit hot spot name, select the name color and select the hot spot icon.

Click OK to save the settings. The alarm input icons are added on the map as hot spots and the
icons of added alarm inputs changes from % to ® in the group list. You can click-and-drag
the alarm input icons to move the hot spots to the desired locations.

You can also click-and-drag the alarm input icons from the alarm input list to the map directly to
add the hot spot.

Linked Alarm input Hel Spot Mame: Hot Sgot Golor Hol Spotlcon ~
DVR_A1 DVR_A1 @ creen @
DVR_A2 DVR_AZ @ cum @
DVR_A3 DVR_43 =TT |
DVR_A4 DVA_A4 @ creen B
DVR_A5 OWR_85 @ creen B
DVR_AS OVR_AG W creen B
DVR_AT DVR_A7 W Geen B
DVR_AB DVR_A8 W Green B
DVR_A2 DVR_A2 W Green B
DVR_A1D DVR_A10 B creen B
DVR_A 11 DVR_AT1 Bl ceen B

5.2.2 Modifying Hot Spots

Purpose:

You can modify the information of the added hot spots on the map, including the name, the color, the

icon, etc.

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Select the hot spot icon on the map and then click %2 inthe toolbar,
or double-click the hot spot icon on the map to open the Modify Hot Spot dialog box.

3. You can edit the hot spot name in the text field and select the color, the icon and the linked
camera or alarm input.

4. Click OK to save the new settings.

To delete the hot spot, select the hot spot icon and click % in the toolbar.
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DVR_Camerald DVR_A3
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DVR_Camers12 - DVR_AT -
Hot Spol Color. @ Green HetSpot loon. (& Hot Spol Color. @ Green HotSpotlcan. @

__

5.2.3 Previewing Hot Spots

Steps:

1. Click the Map Preview button in the E-map toolbar to enter the map preview mode.

2. Double-click the camera hot spots, and you can get the live video of the cameras.

3. If there is any alarm triggered, an icon B wil appear and twinkle near the hot spot. Click the
alarm icon, and then you can check the alarm information, including alarm type and triggering
time.

i

(nore]

To display the alarm information on the map, the Alarm on E-map functionality needs to be set
as the alarm linkage action.
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5.3 The Hot Region Function

Purpose:

The hot region function links a map to another map. When you add a map to another map as a hot
region, an icon of the link to the added map is shown on the main map. The added map is called child
map while the map to which you add the hot region is the parent map.

!;: 1
[[NoTe]

A map can only be added as the hot region for one time.

5.3.1 Adding Hot Regions

Before you start:

Add another map to the group.

Steps:

Click the Edit Map button in the E-map toolbar to enter the map editing mode.

Select an added map as the parent map.

Click the icon E# in the toolbar to open the Add Hot Region dialog box.

Check the checkbox to select the child map to be linked.

Optionally, you can edit the hot region name, and select the hot region color and icon.

Click OK to save the settings. The child map icons are added on the parent map as the hot regions.
You can click-and-drag the child map icons to move the hot regions to the desired locations.

o g bk~ w DN PR

Ada Hat Region x|
Linked Map Hol Region Name Hot Region Hol Region lean

Hant Map! B creen M
Hap2 HWap2 @ cun M

5.3.2 Modifying Hot Regions

Purpose:

You can modify the information of the hot regions on the parent map, including the name, the color,
the icon, etc.

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.
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2. Select the hot region icon on the parent map and then click %2 inthe toolbar,
or double-click the hot region icon to open the Modify Hot Region dialog box.

3. You can edit the hot region name in the text field and select the color, the icon and the linked
child map.
4. Click OK to save the new settings.

To delete the hot region, select the hot region icon and click &2 in the toolbar.

Hat Region Mame: Mapt
Linked Map:
-4 Mapt
Map2
HotRegion Color. [l Green | Hed Region lcon: | (9] - |

5.3.3 Previewing Hot Regions

Steps:
1. Click the Map Preview button in the E-map toolbar to enter the map preview mode.
2. Click the hot region icon to go to the linked child map.
3. The hot spots can also be added on the hot regions.
4. You can click the icon &3 in the toolbar to go back to the parent map.
You can also click the icon B i, the toolbar to clear the alarm information.
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Chapter 6 Log Management

Purpose:

2 types of log files are provided: client logs and server logs. The client logs refer to the log files of the
client and are stored on the local PC; the server logs refer to the log files of the connected devices and
are stored on the local device.

=,

Click the % icon on the control panel to open the Log Search page.

Lag Search Chem Log Lists [ Log Firer L& Backup Log

S Operation Tirme ~ [UserName  LogTroe Desciplion Device Name Diesice Tioe o

GenerlLogs

2013-00-29 230979

Q, search

Talal & Page W1 1 Page o

Searching Log Files

Steps:

1. Open the Log Search page.
Select the log type. If Server Logs is selected, then click to specify the device for search.
Click the icon E to specify the start time and end time.
Click Search. The log files between the start time and end time will be displayed on the list.
You can check the operation time, description and other information of the logs.

o

NoTe

o N

Up to 90000 items of logs can be displayed. Please narrow the time range or filter the log type
for search if there are too many log files.
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Operation Time “ |UserMame |Log Type

2013-08-20 13:20:41
2013-08-201321:45
2013-06-20 13:23:30
2013-06-2913:24:03
2013-06-2913:24:41
2013-06-29 13.:26:03
2013-06-29 13.26:20
2013-08-29 13:27:28
2013-08-29 13:27:58
2013-08-29 13:26:00
2013-08-29 13:20:05
2013-08-29 13:30:20
2013-08-29 13:37:67
2013-08-29 13:38:34
2013-08-29 13:40:20
2013-08-29 13:40:32
2013-08-29 13:41:56
2013-08-29 13:42:20
2013-08-29 13:42:58

Filtering Log Files

Purpose:
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oot
root
root
root
ront
ront
ront
ront
ront
ront
ront
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Syatem Log
Alarm Log
Alarm Log
Alarm Log
Alarm Log
Aarm Log
Aarm Log
Aarm Log
Aarm Log
Aarm Log
Oparation Log
Aarm Log
Oparation Log
Oparation Log
Aarm Log
Oparation Log
Aarm Log
Aarm Log

Aarm Log

Description
UszerLogin

Mation Detection &
Mation Detection &
Malion Detectian &
Malion Detectian &
Mation Dataction &
Mation Dataction &
Mation Detadian &
Mation Detadian &
Mation Detadian &
Add Map

Mation Datachan A
Add Map

Add Map

Mation Datachan A
A Hot Region
Mation Datachan A
Mation Datachan A

Mation Detacian 4

Device Mame

VR

Pc2
IPC2
IPC2
IPC2
IPC2
IPC2
IPC2
IPC2

IPC2

IPC2
IPC2
IPC2

Denice Type Gro

Encoding D evice OF
Encoding Device IPC
Encoding Device PC
Encoding Device PC
Encoding Davice IPC
Encoding Davice IPC
Encading Davice IPC
Encading Davice IPC

Encading Davice IPC

Encading Oavice IPC

Encoding D vice DVF

Encading Oavice IPC
Encading Oavice IPC

Encading Oavice IPC

After searched out successfully, the log files can be filtered by the keyword or condition, and thus you

can find the logs as you want.
Steps:

1. Click Log Filter or the icon ~=  on the Log Search page to expand the Log Filter panel.
2. Select Filter by Keyword, and then input keyword for filtering in the text field; or
select Filter by Condition, and then specify log information in the drop-down list.

3. Optionally, you can click More... to filter the log files more accurately.
Click Filter to start filtering. You can click Clear Filter the clear the filtering.

Senver Log Lisls

Fifter by Keyword:
# hiter by Condition:
Major Type: Al

Minor Type: Al

Backing up Log Files

Purpose:

"% Log Filtel [d Backup Log
Clear Filter
Mare
{
Filter

The log files, including the client logs and server logs, can be exported for backup.

Steps:

1. Click Backup Log to open the Backup Log dialog box.

2. Click the icon

and select a local saving path.

3. Click Backup to export the log files for backup.

You can click File—>Open Log File to check the information of the backup log files on local PC.
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Backup Log

Saving Path:
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Chapter 7 Account Management and System

Configuration

7.1 Account Management

Purpose:
Multiple user accounts can be added to the client software, and you are allowed to assign different
permissions for different users if needed.
f.l
Click the s icon on the control panel,

or click Tool->Account Management to open the Account Management page.

UgerList Add Lisor Edit Lisar
Ing=s User Hams Tme

A rant Bupar ioar

[NoTE

The user account you registered to log in the software is set as the super administrator.

Adding the User

Steps:

1. Open the Account Management page.

2. Click Add User to open the Add User dialog box.

3. Select the user type from the drop-down list. 2 types of user accounts are selectable:
Administrator: The administrator account has all permissions by default, and can modify the
passwords and permissions of all operators and its own account.

Operator: The operator account has no permission by default and you can assign the permissions
manually. An operator can only modify the password of its own account.
Input the user name, password and confirm password as desired.

Check the checkboxes to assign the permissions for the created user.
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6. Optionally, you can click Default Permission to restore the default permissions of this user.
7. Click Save to save the settings.
P
! NOTE]|
® The user name cannot contain any of the following characters: /\ : * ? “ <> |. The administrator
password cannot be shorter than 6 characters, and the operator password cannot be empty.

®  Up to 50 user accounts can be added for the client software.

User Information
UsBr Typs: Adrinistrator [ e User Name:
Fassword: Confirm Password:
User Live View related
S Al ~ | |l= = DVR =
+ Live View 1 DVR_Cameral
| PTZ Control < DVR_Camera2
7 Capture ' DVR_Camera3 i
< Record ~' DVR_Camerad
| Camera Setings L ~ DVR_Cameras
+ Plar Back Remots Record File(s) < DVR_Camerad
< Download Remote Record File(s) + DVWR_Camera?
4 Remote Recording ' DVR_Camerad
' Two-wayAudia < DVR_Camarad
< Synchronizafion + DMR_Camerall
< Piciure Backup + DVR_Camerali
~" Backup Record Filels) - < DVR_Camera’l2

Default Permission m

Managing the User

Purpose:

After created successfully, the user account is added to the user list on the Account Management page.
You can edit or delete the information of the user accounts.

To edit the information of the user, select the user from the list, and click Edit User.

To delete the information of the user, select the user from the list, and click Delete User.

7.2 System Configuration

Purpose -
The general parameters, file saving paths, keyboard and joystick shortcuts, alarm sounds and Email
settings can be configured.

Click the == icon on the control panel,
or click Tool->System Configuration to open the System Configuration page.
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., Fils

sed parameiers

time. dispisy scale. play performance. tc.)

—
=4, Keyboard and Joystick

[ Log Expirea Time: [aMantn -
2| Alarm Sound
Vigw Scale: Full Screen v
~ | Email )
- HeEtwork Perfarmance: (Mormal |Befrer | Best|
Flay Periormance. Real Time -

< Engblz Sereen Toolbar Display

Enabls Auto-login
' Proritize the Flagback of Record Files an Starage Senver
< Resume Live View Status

< Auto-change Stream Type

Aito TIme Adjustment: 0000 00

Default Valus Sawe

ﬁ'— :
[Nore]

You can click Default Value to restore the defaults of all the system configurations.

7.2.1 General Settings

Purpose:

The frequently-used parameters, including the log expired time, view scale, etc., can be set.
Steps:

1. Open the System Configuration page.

2. Click the General tab to enter the General Settings interface.

3. Configure the general parameters. For details, see Table 7-1 General Parameters.

4. Click Save to save the settings.

Set frequently uzed parametars
(Log expired time. dispiay scale, piay perfermance, etc ).

Log Explrad Tima |amontn |~
View Scala Full Seraen |~
Nefwork Ferformance. |Norn1a_|i Betler| | Best|

Play Performanca: Real Time | >

</ Enzble Scraen Taolbar Display

Enable Auto-login

LY

Friontize the Playoack of Record Flles on Storage Sener

(N

Resume Live View Stalus
o Auto-change Stream Type

Auto Tima Adjustment: 00:00:00
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Table 7-1 General Parameters

Parameters

Descriptions

Log Expired Time

The time for keeping the log files, once exceeded, the files will be deleted.

View Scale

The view scale of the video in live view or playback. It can be set as Full
Screen, 4:3, 16:9 or Original Resolution.

Network Performance

The current network conditions. It can be set as Normal, Better or Best.

Play Performance

The play performance of the live video. It can be set as Shortest Delay, Real
Time, Balanced or Fluency.

Enable Screen Toolbar
Display

Show the toolbar on each display window in live view or playback.

Enable Auto-login

Log in the client software automatically.

Prioritize the Playback
of Record Files on

Storage Server

Play back the video files recorded on the storage server preferentially.
Otherwise, play back the video files recorded on the local device.

Resume Live View
Status

Resume the latest live view status after you log in the client again.

Auto-change Stream
Type

Change the stream type automatically in live view according to the size of
the display window.

Auto Time Adjustment

Adjust the time automatically at a specified time point.

7.2.2 File Saving Path Settings

Purpose:

The video files from manual recording, the captured pictures and the system configuration files are
stored on the local PC. The saving paths of these files can be set.

Steps:

1. Open the System Configuration page.
2. Click the File tab to enter the File Saving Path Settings interface.

3. Click the icon

and select a local path for the files.

4. Click Save to save the settings.
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Set file savn

(e.g record files, picturas and device configuation filas, atc.)

Saving Path of Video File
{Clivms£200hideo/

Having Path of Pictures
Cilivmz4200fcapiure!

Saving Path of Corfiguration File:

Cilivma4200fconiin!

7.2.3 Keyboard and Joystick Shortcuts Settings

Purpose:

RS-485 keyboard can be connected to the client and be used to control the PTZ cameras. You can set
the shortcuts of PC keyboard and USB joystick to get quick and convenient access to the commonly
used actions.

Steps:

1. Select the COM port from the drop-down list if 1003K keyboard is connected.

Select a certain function from the list.

Double-click the item field under the PC Keyboard or USB Joystick column.

Select the compound keys operation or USB joystick operation from the drop-down list.

Click Save to save the settings.

a > D

Configure 1003K keyboard COM
PC keyboard and USB joystick shortcuts, etc

1003K COM Joystick: NULL v

@ Setup shortcuts of PC keyboard and USB joystick for frequently used functions ofthe system

Index Function PC Keyboard USB Joystick
1 Capture Ctrl + Print Screen ‘
2 Speed Up
3 Speed Down
4 Focus (+) Ctrl + Home
5 Facus (-) Ctrl + End
6 ZoomIn (+) Ctrl++
7 Zoom Qut (-} Ctrl + -
8 IRIS (+) Ctrl + Page Up
9 IRIS (-} Ctrl + Page Down
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7.2.4 Alarm Sound Settings

Purpose:

When the alarm, such as motion detection alarm, video exception alarm, etc., is triggered, the client
can be set to give an audible warning and the sound of the audible warning can be configured.

Steps:

1. Open the System Configuration page.

Click the Alarm Sound tab to enter the Alarm Sound Settings interface.

Click theicon |"”" and select the audio files from the local path for different alarms.

Optionally, you can click theicon *¥ for a testing of the audio file.
Click Save to save the settings.

a s w D

NoTe

The format of the audio file can only be *wav.

Set alarm sound

(2.3 motion detection alarm video axception alzmm, alarm nput and device exception alzmm

Motion Detaction

(molion way 17
Videq Excaption:

video_abnormal.way

Alarm Input:

alarm_inputway

Device Exception:

device_abnormalwav

7.2.5 Email Settings

Purpose:
An Email notification can be sent when a system alarm occurs. To send the Email to some specified
receivers, the settings of the Email need to be configured before proceeding.
Steps:
1. Open the System Configuration page.
2. Click the Email tab to enter the Email Settings interface.
3. Input the required information.

SMTP Server: Input the SMTP Server address.

Port: Input the communication port of Email service. The port is 25 by default.

User Name: Input the user name of the sender Email address.

Password: Input the password of the sender Email address.
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Sender Address: Input the Email address of the sender.
Receiver 1—3: Input the Email address of the receiver. Up to 3 receivers can be set.

Optionally, you can check the checkbox Enable SSL to increase the security of email sending.

Optionally, you can click Send Test Email to send an email to the receiver for test.
Click Save to save the settings.

Set emall parametars icluding sender and racipiant

SUTP Senar |
Port 25
Liszr Mame
Passwarg:
SenderAcdress:
Receiver 1:
Recsiver 2
Receiver 3

Enable 5SL

Send Test Email
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Chapter 8 Forwarding Video Stream through

Stream Media Server

Purpose:

There is always a limit of the device remote access number. When there are many users wanting to get
remote access to the device to get the live video, you can add the stream media server and get the
video data stream from the stream media server, thus to lower the load of the device.

8.1 Adding the Stream Media Server

Before you start:

The stream media server application software needs to be installed and it is packed in the Safire
Control Center software package. When installing the Safire Control Center, check the checkbox
Stream Media Server to enable the installation of stream media server.

Steps:

1. Click the shortcut icon Fl‘i on the desktop to run the stream media server.

L
[[NoTe
You can also forward the video through the stream media server installed on other PC.
Open the Device Management page and click the Server tab.
Click Add New Device Type, select Stream Media Server and click OK.
Click Stream Media Server on the list and then click Add Device.
You can add the stream media server in the following two ways:
® Adding Stream Media Server Manually
Perform the following steps to add the stream media server manually:
1) Select IP Address as the adding mode.
2) Input the nickname and IP address of the stream media server. The default port value is
554,
3) Click Add to add the stream media server to the client software.

Adding Moge:

= P Address P Sagment

Micknarme: | |

IF Address

Part

® Adding Stream Media Server by IP Segment
Perform the following steps to add the stream media server by IP segment:
1) Select IP Segment as the adding mode.
67



User Manual of Safire Control Center

2) Input the start IP and end IP. The default port value is 554.
3) Click Add to add the stream media server to the client software.

Adding Moge:

1P Addrecs @ P Sggment

oo | canca |

ﬁ'— :
[Nore]

For one client, up to 16 stream media servers can be added.

8.2 Adding Cameras to Stream Media Server to Forward

Video Stream

Purpose:

To get the video stream of a camera via stream media server, you need to connect the camera to the
stream media server.

Steps:

1. Select the stream media server from the list.

2. Click configure to enter the Stream Media Server Settings interface.
3. Select the cameras of which the video stream is to be forwarded via the stream media server.
4. Click OK to save the new settings.
5. Go the Main View page and start the live view of the cameras again. You can check the channel
number of the video stream forwarded through or sent from the stream media server.
L
vore]

For one stream media server, up to 64 channels of video stream can be forwarded through it and
up to 200 channels of video stream can be sent to clients from it.

siream e sere Seimgs ] ——— R ———.

b = bl * 17:04:20
Bl = Configurs Agnul Mo 3 BT
* | D¥R-Encoding Channel
o Cperation Clignt IP Client Por Time
4 (@ DVR_Cameral = Eniler 1726 23.106 52315 2013-06-29 17 04 08

¥ (i DVR_Camera3 Enar 172623906 52318 S013-06-29 17 04 08

@ DVR:-Camarad Enler 172622108 52317 2013-08-29 170408

@ OVR_Cameras
@ DVYR_Camarat
@ DYR_Camera?
@ DVR_Camaral
il DVR_Gamerad
|@ DVR_Camerain

@ OVR_Cameratd

(o I corce |
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Chapter 9 Decoding and Displaying Video on
Video Wall

The Video Wall module is only available when the decoding device is added to the client. It provides
the video decoding functionality, and the decoded video stream can be displayed on the Video Wall
for an attention-grabbing performance.
Gl
) ==
Click the WEE| jcon on the control panel,

or click View->Video Wall to open the Video Wall page .

camara Dt Widen Wall

R
C P
+ I HR
Fc2

Speed Dome

Layout
Trirg Park Devices.
PTZ

BE8. Enter Viden Wall Corfig W =

LEH|
[+
| ®
J
r'ﬁ|

9.1 Adding the Decoding Device

Purpose:

To display the video on the Video Wall, the decoding device needs to be added to the client.
Steps:

1. Open the Device Management page and click the Server tab.

2. Click Add New Device Type, select Decoding Device and click OK.

3. Click Decoding Device on the list to enter Decoding Device Adding interface.
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=l - Group
Olgmulinn Dievice for Wanagement (1)
&8 Encodn g Devico - "IE"JD!\\\'.E Moafy Diete Remate Canfig ber
_ Hicknama - P Dewice Sartal Ho. Mat Staius
ER storags Serer Decoder 262265 DSASIIDIEANIZ07ITACRRAIOTIOBTOAL )

ol Slream Meda Sensr

Oniling Device (D) Refresh Every 155

Dacoding devica can ba andsd
DecodenTVMS-4200 Decoding 3enver

You can add the decoding device in the following ways:

® By detecting the online devices, see Section 2.2.1 Adding Online Devices.

® By specifying the device IP address, see Section 2.2.2 Adding Devices Manually.
® By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment.
® By IP Server, see Section 2.2.4 Adding Devices by IP Server.

9.2 Configuring Video Wall Settings

Purpose:

After the decoding device is added successfully, the parameters of Video Wall need to configured for

video display.

Steps:

1. Open the Video Wall page.

2. Click Enter Video Wall Config to enter the Video Wall Configuration interface.

3. Thereisa3*3video wall on the screen by default. You can add a new video wall if needed.
Perform the following steps to add a new video wall:

1) Click the icon in the toolbar to open the Add Video Wall dialog box.
2) Input the nickname, the number of rows and columns of the video wall.

3) Click Add.
e

Video Wall Name: [| l

Row: 3

Column: 3

Cancel

To modify the video wall, select the video wall, and click the icon k2 in the toolbar.
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To delete the video wall, select the video wall, and click the icon | in the toolbar.
4. Click-and-drag the decoding channel on the left-side list to the display window of video wall, to

connect them one-to-one correspondence. You can click B in the upper-right corner of the
display window to release the connection.

J_

® Up to 4 video walls can be added to the client software.

® The total number of the display windows on the video wall should be no more than 100.
® The ranges of the row number and column number are both between 1 and 20.

Defnull Video Wall

9.3 Displaying Video on Video Wall

Purpose:
After the settings of the video wall are configured, the video stream from the cameras can be decoded
and displayed on the Video Wall.
Steps:
1. Click Back to Operation Page to go back to the Video Wall Operation interface.
2. Select the screen layout mode for the display window.
3. Click-and-drag the camera from the left-side list to the display window on the video wall.
The video stream from the camera will be decoded and displayed on the Video Wall. Click the

icon ™ and you can get a preview of the video in the lower-right corner of the screen.
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Camera Detault Video Wall
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Troubleshooting

Live View

Problem:

® Failed to get the live video of a certain device.

Possible Reasons:

® Unstable network or the network performance is not good enough.

® The device is offline.

® Too many accesses to the remote device cause the load of the device too high.
® The current user has no permission for live view.

® The version of the client software is below the needed version.

Solutions:

® Check network status and disable other not in use process on your PC.

® Check the device network status.

® Restart the device or disable other remote access to the device.
® Log in with the admin user and try again.

® Download the client software of the latest version.
Recording

Problem:

® Local recording and remote recording are confused.

Solutions:

® The local recording in this manual refers to the recording which stores the record files on the
HDDs, SD/SDHC cards of the local device.

® The remote recording refers to the recording action commanded by the client on the remote
device side.

Playback

Problem:
® Failed to download the record files or the downloading speed is too slow.
Possible Reasons:
® Unstable network or the network performance is not good enough.
® The NIC type is not compatible.
® Too many accesses to the remote device
® The current user has no permission for playback.
® The version of the client software is below the needed version.
Solutions:
® Check network status and disable other not in use process on your PC.
® Directly connect the PC running the client to device to check the compatibility of the NIC card.
®  Restart the device or disable other remote access to the device.
® Log in with the admin user and try again.
® Download the client software of the latest version.
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